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Lesson Objectives

® Gain an overview of payroll in QuickBooks

® Learn more about payroll setup

® Setup employee payroll information

® Setup payroll schedules

@ Practice writing and printing a payroll check

® Learn how QuickBooks tracks your tax liabilities

@ Practice paying payroll taxes
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Setup for Payroll

Keep in mind you must subscribe to one of the available QuickBooks Payroll services that work with
QuickBooks Desktop in order to run payroll in QuickBooks. However, you can test the features of
QuickBooks Payroll using one of the sample companies such as Rock Castle Construction. Do not
use this feature for actual payroll as the rates are not accurate.

If you want to turn on or off payroll in a company file, follow the procedure below.

@
2! Step-by-Step: Turn Payroll Off in a Company File

1. Make sure you are signed in to the QuickBooks company as the Admin user. (If other users have
been set up on other computers to access the company in multi-user mode, ensure they are not
signed in and you are in single-user mode.)

2. From the Edit menu, choose Preferences then click Payroll & Employees in the left panel.

3. To turn payroll off, click the Company Preferences tab and select No payroll. To turn payroll
on, in the same tab, select either Full payroll or Online payroll. (If you turn on payroll, you will
be able to select the subscription of your choice in the Employees menu.)

4. Click OK.

QuickBooks maintains a list for everything that affects the amount on a payroll check and for every
company expense related to payroll. This list is called the Payroll Item List. There are payroll items for
compensation, taxes, other additions and deductions, and employer-paid expenses. QuickBooks
uses payroll items to track individual amounts on a paycheck, and accumulated year-to-date wage
and tax amounts for each employee.

Payroll items affect either payroll liabilities or payroll expenses on the Chart of Accounts by default
(unless you make changes to their setup). However, you will be able to run detailed reports related
to payroll based on the payroll items and how they are used in paychecks and payroll liabilities
payments.
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@
2! Step-by-Step: View the Payroll Item List

1. From the Employees menu of a QuickBooks sample company, choose Manage Payroll Items
then choose View/Edit Payroll Item List. (You must have payroll turned on to see this choice in
an actual company.)

Payroll ltem List

ITEM MAME i TYFE PAMOUNT | LIMIT I TAX TRAC.. | PAYABLE TO | ACCOUNT ID
Sick Salary Yearly Salary Compensa... I
vacation Salary Yearly Salary | | \Compensa...| |
Overtime Rate Hourly Wage Compensa...
Regular Pay |H0urlyWage | | |Compensa...| |
Sick Hourly Hourly Wage Compensa...
Wacation Hourly |H0urlyWage | | |Compensa...| |
Bonus Bonus 0.00 Compensa...
Mileage Reimb. |Addi1i0r| | n.45| |Compensa...| |
Health Insurance Deduction -1,200.00 Mone
Waorkers Compensation |c:ompany c| | |N0r1e |Sta1e Fund |
Advance Earned Incom... Federal Tax Advance El.. |Great State .. |00-7904153
Federal Unemplayment |Federal Tax | U.E%| ?,UUU.UU|FUTA |GreatState... |00-7904153
Federal Withhaolding Federal Tax Federal Great State...  00-7904153
Medicare Company |Federal Tax | 1.45%| |Comp. I'u'led...|GreatState... |nn-?904153
Medicare Employee Federal Tax 1. 455% Medicare Great State... 00-7904153
| | | | | | hi
Payroll [tem Activities Reports |+ Include inactive

2. Close the Payroll Item List.

NOTES
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If you need to add a payroll item after you've set up payroll in QuickBooks, use the following
procedure.

@
o Step-by-Step: Add a Payroll ltem

1. From the Employees menu, choose Manage Payroll Items then choose New Payroll Item.
2. Select Custom Setup then click Next.

3. QuickBooks displays the Add new payroll item window, which walks you through the payroll item
setup process.

Add new payroll item x

S—won Payroll item type

Ty i =

,‘g Select the type of payroll item you want to create.
éﬁ'ﬁh éﬂage (Hourly Wages, Annual Salary, Commission, Elonus}é

&

@

Addition (Employee Loan, Mileage Reimbursement)

Deduction (Union Dues, 401(k) deferral, Simple IRA, HSA)

Company Contribution (Employer 401(k) matching contribution, HSA contribution)
Eederal Tax (FUTA, Social Security, Medicare)

State Tax (State Withholding, SDI, SUI)

Other Tax (Local Tax, Misc. State Tax)

Q0000

Back m Finish Help Cancel

4. Select the type of payroll item you want to create then click Next.
5. Follow the onscreen instructions to create the payroll item.
6. When you are done, click Finish.

7. Close the Payroll Iltem List.

NOTES
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Set Up Employee Payroll Information

QuickBooks calculates payroll for each employee on the basis of that employee’s pay rate, marital
status, exemptions and so on. The Employee list stores general information about each employee as
well as payroll information.

@
9! Step-by-Step: View Information Stored in the Employee List

1. Click Employees on the icon bar to open the Employee Center.
2. Selectthe employee you wish to view from the list then right-click and select Edit Employee.

3. Click the Address & Contact tab to enter the employee’s address, phone number and
emergency contact details.

4. Click the Additional Info tab to access the employee ID or account number, billing rate level
and custom fields.

5. Click the Payroll Info tab to set up the employee pay schedule, additions, deductions and
company contributions.

6. Use the buttons on this tab to access additional information for direct deposit, taxes and
sick/vacation pay.

= Edit Employee =
INFoRMeTION FOrR Dan T. Miller
Pl ravROLL scHEDULE | [SITELELAN] - Direct Deposit Taxes...
Address & Contact FRY FREQUENCY  Bivweakly - "
SickVacation...
Additional Info cLass h
Payroll Info
EARNINGS ADDITIONS, DEDUCTION § AND COMPANY CONTRIBUTION §
Employment Infa ITEM NAME i HOURLY/ANNUAL RATE ITEM NAME i AMOUNT DT
Salary 41 500.00 & Health Insurance -25.00 -G00.00 |4~
Workers' Comp
v v
(] Use time data to create paychecks 1 Employee is covered by a qualified pension plan
"] Employee is inactive @ Cancel Help
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7. Click OKto return to the Edit Employee window from the additional information boxes.

8. Click OK again to return to the Employee Center

NOTES
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Use Employee Defaults to Store
Common Information

QuickBooks stores a wealth of information about each employee, but it doesn't require you to enter
the same information over and over. When you have information that applies to most of your
employees, you can enter it into your employee defaults. Then when you add an employee,
QuickBooks automatically fills in the information stored with those employee defaults. You will need
to add or change any information that is different for a particular employee.

@
2! Step-by-Step: View Employee Defaults

1. From the Employee Center, choose Change New Employee Default Settings from the Manage
Employee Information menu button.

Employee Defaults

-
EARMING S
ITEM MAME ¢ HOURLY/AMMUAL RATE

Schedule

|Regular Pay o Pay Frequency Biweekly - Cancel
Class -

‘ | v = Help

- . What is a payroll schedule?
|| Usetime data to create paychecks

ADDITION S, DEDUCTION 5 AND COMPANY CONTRIBUTION 3

ITEM NAME  AMOUNT ELIMIT Taxes...

Sick/VMacation...

] Employee is covered by a qualified pension plan

2. Setthe default pay schedule, earnings items, etc. from the window.

3. Use the Taxes button to set up the default state/federal tax settings.
4. Click OKto close the Taxes Defaults window.

5. Click Sick/Vacation to modify the default settings then OK to close it.

6. Click OK to close the Employee Defaults window.
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Set Up Payroll Schedules

You can set up payroll schedules to group employees with the same pay frequency (daily, semi-
monthly, bi-weekly and monthly). You define how often you pay your employees, which date their
paycheck is due and which day you run payroll. QuickBooks calculates your upcoming payroll
schedule so you can pay your employees on time.

Using payroll schedules is a quick and convenient way to pay your employees each pay period. You
set up the payroll schedule one time, assign the payroll schedule to the appropriate employees and
QuickBooks calculates the due dates for each upcoming pay period.

You do not need payroll schedules to run payroll, however. You can run payroll without them by
running Unscheduled Payroll or paying an employee a termination check.

@
9! Step-by-Step: Define a Payroll Schedule

1. From the Employees menu, choose Add or Edit Pay Schedules.

2. Click the Payroll Schedule menu button at the bottom left then choose New.

= New Payroll Schedule — O x

The information you provide will be used to create a payroll schedule. What is a payroll schedule?
You can set up multiple payroll schedules if you need to. Why do | need multiple schedules?

Tell us how you'll be processing payroll using QuickBooks Desktop: How do | setup a payroll schedule?

What do you want to name this payroll schedule? (e.g., *Weekly", “Biweekly", “Monthly”, etc) Monthly
How often will you pay your employees on this schedule? Maonthly -

What is the pay period end date? 1213172021 ]

What date should appear on paychecks for this pay period? m

What day should appear on paychecks for this pay period? last day of month -

The following is based on the information supplied above:
You pay your employees on the same day as the pay period end date in this payroll schedule.
The paycheck date for the current month is 12/31/2021 for the pay period ending on 12/31/2021.

Schedule is inactive B o
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3.

8.

9.

Enter a name for your payroll schedule in the What do you want to name this payroll schedule?
field.

Press Tab and select the pay frequency.
Press Tab and select the pay period end date for the next period you wish to run payroll.

Press Tab and select the date that should appear on the checks for the next period you wish to
run payroll.

Press Tab and select the day that should appear on the checks for the next period you wish to
run payroll.

Click OK.

Repeat as needed to set up your pay schedules.

10. Close the Payroll Schedule List.

Now that you've set up the pay schedules, you can assign each employee to the appropriate pay
schedule.

O

Step-by-Step: Assign a Pay Schedule

From the Employees menu, choose Employee Center.

2. Click the Employees tab in the left section.

3. Right-click on the employee you wish to assign a pay schedule to then select Edit Employee.
4. Inthe Edit Employee window, choose the Payroll Info tab.

5. From the Payroll Schedule drop-down list, select the pay schedule you wish to assign.

6. Click OK.

7. Repeat the steps for each employee to assign the proper pay schedules.

NOTES
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Add a New Employee

@
o1 Step-by-Step: Add a New Employee

1. With the Employee Center displayed, click New Employee at top left.

2. Enter the corresponding information in the Personal, Address & Contact and Additional Info
fields.

3. Inthe Payroll Info tab:

® Assign the Payroll Schedule from the drop-down list

® Choose the earning items that apply to this employee in the Earnings grid (e.g., salary,
hourly, overtime, etc.)

® Choose any items that apply to the employee from the Additions, Deductions and Company
Contributions grid

® Click the Direct Deposit button to set up direct deposit information
® Click the Taxes button to set up federal withholding and state tax information
® Click the Sick/Vacation button to add any sick/vacation time accrual information

= New Employee — O x
InFoRMeTION FoR  Michael E. White
Personal - =
FEYROLL SCHEDULE | Biweekly - . Direct Deposit Taxes...
Address & Contact FEY FREQUENCY  Biweekly v . .
Sick/Vacation...
Additional Info cLass M
Payroll Info
EARNINGS ADDITION 5, DEDUCTION § AND COMPANY CONTRIBUTION S
Employment Info ITEM NAME | HOURLY/ANNUAL RATE ITEM MAME i AMOUNT L umiT
Regular Pay 15.00|‘ |Hea|th Insurance -20.00 -1,200.00| 4
Workers' Comp
v v
I [ Use time data to create paychecks I | Employee is covered by a qualified pension plan
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= IMPORTANT: If you would like the time automatically entered from timesheets, place a check in the box
labeled Use time data to create paychecks.

4. Enter remaining information in the Employment Info and Workers' Comp tabs.

5. Click OK.

NOTES
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Run a Payroll Schedule

QuickBooks lets you print payroll checks in a batch based on payroll schedules.

@
2! Step-by-Step: Run a Payroll Schedule

1. Inthe Employee Center, click the Payroll tab in the left section.
2. Inthe right section, click the Pay Employees tab.

3. Inthe Pay Employees section, choose the Biweekly pay schedule.

Run a Payroll Schedule

4. Click the Start Scheduled Payroll button. (If the Special Paycheck Situation window pops up,

click Continue.)

5. Specify the last date of the pay period, check date and bank account from which paychecks will
be produced, and whether the checks are to be printed or handwritten. If they are handwritten,

specify the first check number.

Enter Payroll Information

o Enter Payroll
Information

PAYROLL INFORMATION

How do | pay my employees?

FEYROLL SCHEDULE: Biweekly AV PERIOD ENDS | 12/31/2021 4 BANK ACCOUNT

10100 - Checking -

12/31/2021

EMFLOYEES SELECTED TO FAY: 4 CHECK DATE BANK ACCOUNT BALANCE: 48 687.70
Explain Printing Options
CHECK OPTIONS
® Print paychecks on check stock First Checks#
" Handwrite & Assign check numbers 4491
Uncheck All Open Paycheck Detail... SORTEY  Employee Name - Show/Hide Columns
J | EMFLOYEE ! REGULAR FAY | OVERTIME R.. ! SICKHOURLY | VACATIOMH.. | SALARY i TOTAL HOURS
w | Dan T Willer -
v | Elizabeth M. Mason 80:00 80:00
Gregg O. Schneider 80:00 80:00
Michael E. White
v
How do | use this window to enter payroll information? Finish Later

QuickBooks 2017 Student Guide
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Lesson 12 —Payroll with QuickBooks Run a Payroll Schedule

6. Selectthe employees you wish to pay by ensuring there is a checkmark next to their name in the
grid.

7. Click Continue.

Rewview and Create Paychecks

) Review & Create
Paychecks
How do | pay my employees?
PAYROLL INFORMATION
PAYROLL SCHEDULE: Biweekly PAY PERIOD ENDS 12312021 @ BANK ACCOUNT 10100 - Checking -
MUMEER OF FEYCHECKS: 4 CHECK DATE 1203102021 B BANK ACCOUNT BALANCE: 48 687.70
Explain Printing Options
CHECK OPTION §
@ Print paychecks on check stock First Checks#
) Handwrite & Assign check numbers 491
Open Paycheck Detail...
Employee Gross Pay Taxes Deductions MetPay  Employer Taxe Contributions Total Hours Direct De|
Dan T. Miller 1,596.15 -213.90 0.00 1,382.25 12211 266.11 &
Elizabeth M. Mason 1,180.00 -234 67 0.00 945 33 9027 12118 80:00
Gregg O. Schneider 1,380.00 -290.85 -12.50 1,076.65 105.57 13.11 80:00
§Michae| E. White 150.00 -18.83 -20.00 117 20.26 0.00 10:00
v
4,306.15 -758.25 -32.50 351540 33821 400.40 170:00
< Back Finish Later Create Paychecks

8. To review all paychecks, click the Open Paycheck Detail button or, to review one paycheck,
click on the employee’s name in the grid.

9. Once you've reviewed all the paychecks you want to review, click Save & Close to return to the
Review & Create Paychecks window.

10. Click Create Paychecks.
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Run a Payroll Schedule

QuickBooks creates a payroll check for each employee in the chosen payroll schedule for the
correct net amount, showing the deductions in the voucher area. QuickBooks confirms you have
created the paychecks. You can then choose Print Paychecks (or Print Pay Stubs if they are
going to be handwritten checks).

Confirmation and Next Steps

You have successfully created 4 paychecks:

Next step:

Print your paychecks/stubs, and distribute to employees.

Print Paychecks Print Pay 5tubs

"1 Do not advance the dates of this payroll schedule in the Payroll Center

€ Print & Distribute
Paychecks

4f0rprinting Ofordirect deposit Learn mare

Close

11. If you don't want to print the paychecks now, click Close.

NOTES

QuickBooks 2017 Student Guide
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View the Paycheck

QuickBooks records payroll checks in your QuickBooks bank account register (whichever bank
account you selected when you started to pay these employees). You can see the check by going to
the register and opening it the way you open any transaction in a register, but it is easiest to view
employee checks from the Employee Center.

@
o Step-by-Step: View the Paycheck from the Employee Center

1. From the Employees drop-down menu, click Employee Center.
2. Click the Employees tab in the left section if it isn't already selected.
3. Selectthe name of the employee whose paycheck you want to view.

4. You'll see a list of recent paychecks for that employee in the Transactions tab in the right section
of the Employee Center. Double-click on the paycheck you want to open from the employee’s
transaction list.

Paycheck - Checking

Main Reports

“» § B XBowon @urmaw § B O B B 8 W

Find Mew Save Delete €3 Memorize Print Attach Select  Enter Clear Recalculate Baich Reorder
M M File PO Time Splits Transactions | Reminder =~ Order
Checks
N twtete T gl 10100 - Checking ENDING BALANCE 45172.30
NO. TO PRINT
FRINT AS  Dan Miller DATE |12/31/2021 [
&Y TO THE CRDER OF | Dan T. Miller - 5 1,382.25

Onethousand three hundred eighty-two and 25(00* * *** ****xx x4k k22 kkF 22 x x4 H £33 4% DOLLARS

ADDREES | Dan Miller
195 Spruce Ave, #202
Bayshore, CA94326

MEMO

PAYCHECK SUMMARY

EARNINGS 1,596.15 FAY PERICD 12182021 - 1213172021
ADDITIONS 0.00 HOURS WORKED 0:00

TAXES -213.90

DEDUCTIONS 0.00 paycheck Detail...

Save & Close Revert

5. Click Save & Close to close the paycheck.
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Print Paychecks after Leaving Pay Employees
Window

You can print paychecks after creating them while still in the Pay Employees area. However, you do
not have to print them at that time. You can close the payroll function and print them at any time.

You print paychecks similarly to other QuickBooks checks. If you use voucher checks, QuickBooks
prints the payroll item detail in the voucher area. If you don't use voucher checks, you can print a pay
stub to give to your employees.

@
2! Step-by-Step: Print Paychecks after you Exit the Pay Employees Window

1. From the File menu, choose Print Forms then choose Paychecks.
2. Select the bank account that is the source of the paychecks from the Bank Account drop-down.

3. Enter the starting check number from the check stock on which you are printing in the First
Check Number field.

4. Make sure there's a checkmark next to all employee names whose paychecks you are going to
print then click OK.

Select Paychecks to Print

Bank Account 10100 - Checking = | First Check Number 10080

Select Paychecks to print, then click QK.
There are 4 Paychecks to print for $3,515.40.

4 i DATE ¢ EMFLOYEE £ AMOUNT “

S 1213142021 Dan T. Miller 1,382.25| Cancel
S 12/31/2021 Elizabeth M. Mason 94533
Hel
¥ 1213112021 Gregg 0. Schneider 1,076.65 -
s ) .
1213142021 Michael E. White TMA7 Select All
Select None
Show: & Both " Paychecks " Direct Depasit Preferences

Company message to be printed on all pay stubs:

5. If desired, enter the text for a company message to appear on all pay stubs.

6. Click Print.
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Print or Email Pay Stubs after Leaving Pay
Employees Window

You can print pay stubs after recording paychecks to be handwritten while still in the Pay Employees
area. However, you can close the payroll function and print or email them at any time.

@
2! Step-by-Step: Print or Email Pay Stubs after you Exit the Pay Employees
Window

1. From the File menu, choose Print Forms then choose Pay Stubs.

2. Select the bank account that is the source of the paychecks from the Bank Account drop-down.

Select Pay Stubs b

Bank Account 10100 - Checking - Checks Dated 12M14/2021 B thru 03M4/2022 B
Select Pay Stubs, then click Print or E-mail. Employee All Employees -
There are 9 Pay Stubs to print for $9,039.97.
< 1 DATE i EMPLOYEE i AMOUNT Preview
¥ 1201512021 Dan T. Miller 1,299.60 = Select All
¥ 11211512021 Elizabeth M. Mason 907.92 l B
7 121152021 Gregg O. Schneider 1,033.98 ST
¥ 121502021 Dan T. Miller 1,350.15
¥ 121502021 Elizabeth M. Mason 932.92
12/15/2021 Gregg 0. Schneider 1,062.12 Preferences
12M156/2021 Gregg Q. Schneider 1,06212 v Default Email Text

Show: ® Both ) Paychecks ' Direct Deposit

Company message to be printed on all pay stubs:

Print Email Close Help

3. Specify a date range for listing pay stubs.

4. Make sure All Employees is selected or, if desired, specify one employee.
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5. Place a checkmark next to the employees’ paychecks for which you want to print or email a pay
stub.

6. If desired, enter the text for a company message to appear on all pay stubs.

7. Click Print or Email. If you chose Email, you will see a Password Protection screen. Read the
information and click OK. Follow the prompts to complete any missing employee email

addresses.
Password Protection

ﬁ Important
QuickBooks requires your employees to enter a passwaord to view their pay stubs
when you email them. QuickBooks generates the passwords automatically; each
password consists of the first four letters of the employee’s last name followed by
the last four digits of their Social Security number.

Examples
Mame: SSN: Pay Stub Password:

Ben Marramore  855-56-4545 narr4545
Deb D'Spain Ta2-34-3419 dspa3419
Jimmy Wu 903-88-7465 wu7465

Mote that all characters must be entered in lowercase and punctuation characters
are notincluded in the password. When a last name has fewer than four
characters, the whole last name is used but no additional characters are added.

You will need to inform each employee of this password requirement.

NOTES
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Pay Payroll Taxes

If you're about to pay taxes or other liabilities, the Payroll Liabilities Balances report shows how much
to pay. Suppose you are ready to make a tax payment and you want to see how much you owe.

@
9! Step-by-Step: Create a Payroll Liabilities Report

1. From the Reports menu, choose Employees & Payroll then choose Payroll Liability Balances.
2. Select This Calendar Year in the Dates cell.

3. Click the drop-down menu in the Show Columns section at the top of report then select Year to
change the report display.

= Payroll Liability Balances - 0O x

Customize Report Comment on Report Share Template Memorize Print v | E-mail v Excel v Hide Header Refresh
Dates  This Calendar Year *  From 01012021 B To 12/312021 @& Show Columps ~ Year ~* SortBy Default -

Show | Applied Filters

10:06 AM Rock Castle Construction

121621 Payroll Liability Balances

January through December 2021
BALANCE
 Payroll Liabilities

Advance Earned Income Credit 3 0.00 4
Federal Withholding 1,730.00
Medicare Employee 28325
Social Security Employee 112559
Federal Unemployment 100.90
Medicare Company 26325
Social Security Company 1,125.59
CA - Withholding 36066
CA - Disability Employee 49.43
CA - Unemployment Company 107.88
Medicare Employee Addl Tax 0.00
CA - Employee Training Tax 10.00
Health Insurance 182.50
Workers Compensation 1,614.71
Total Payroll Liabilities 6,933.81

4. Close the report.

NOTES
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Write a Check for Payroll Taxes

When it's time to deposit payroll taxes with your deposit institution, use the Liability Check window
to fill out a special type of QuickBooks check for this purpose.

@
o Step-by-Step: Pay Payroll Liabilities

1. From the Employees drop-down menu, choose Payroll Taxes and Liabilities then click Create
Custom Liability Payments.

2. Inthe From and Through fields, enter the date range for which you are paying the liabilities.

3. Click OK.

4. Complete the information in the Pay Liabilities window to mirror the payment you making:

® Ensure the proper Bank Account is selected
® Enter the proper Check Date
® Place checkmarks next to the liabilities you wish to pay

= Pay Liabilities - O x

« To be printed @ Review liability check to enter
Bk Account expense.sf;.}e.maltles | Cancel
10100 - Checking - 0 f;:’:‘t;’l r':;‘b'my check without Payroll Liabilities Report
Check Date Help
12/31/2021 B SHOW PAYROLL LIABILITIES
SortBy |Payable To - Dates  Custom ~  From | 01/01/2021 B Through [12/31/2021 [
J | PAYROLL ITEM i PAYABLE TO i BALANCE §AMT. TO PAY
CA-Employee Training Tax Employment Development Department 10.00 0.00 &
CA-Unemployment Company Employment Development Department 107.88 0.00
CA-Withholding Employment Development Department 36066 0.00
» Advance Earned Income Credit  Great Statewide Bank 0.00 0.00
» Federal Unemployment Great Statewide Bank 100.90 100.90
» Federal Withholding Great Statewide Bank 1,730.00 1,730.00
» Medicare Company Great Statewide Bank 263.25 26325
» Medicare Employee Great Statewide Bank 263.25 26325
« Medicare Employee Addl Tax Great Statewide Bank 0.00 0.00
» Social Security Company Great Statewide Bank 1,125.59 1,125.59
» Social Security Employee Great Statewide Bank 1,125.59 1,125.59
Workers Compensation State Fund 1,614.71 0.00
v
6,933.81 4608.58
Ending Bank Balance 40,563.72
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Write a Check for Payroll Taxes
5. Make sure Review liability check to enter expenses/penalties is selected, then click Create.

Liability Check - Checking
Main Reports

€® P a E 2@ CreateaCop'_\- E v'| Print Later

HoaA
= = -
0 o BE & @
Find Mew  Save Delete aMemorize Print Attach Select Enter Clear Recalculate Balch Reorder
- - File PO Time Spiits Transactions =~ Reminder =~ COTder
BANK ACCOUNT

ENDING BALANGE 40,563.72
NO. TOPRINT

DATE |12/31/2021
FEY TO THE ORDER OF | Great Statewide Bank

% 4,608.58

Fourthousand Six hu”dred elght aﬂd 58”00**1**-x-x-r-x-x-x-x-x-x-x-xtttttwtttttttttttttt DOLLARS
ADDRESS A
Great Statewide Bank E ";m
P.O. Box 522

Bayshore CA94326

FERICD | 01/01/2021 [

- 1213102021 B
MEMO | 00-7904153

Expenses $0.00 Payroll Liabilities $4,608.58
PAYRCLL ITEM i AMOUNT § MEMC i CLASS
Advance Earned Incom... 0.00 |‘
Federal Unemployment 100.90
Federal Withholding 1,730.00

Save & Close Revert

QuickBooks will create one liability check per institution.

Click Save & Close to record the check.

NOTES
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Payroll with QuickBooks - Review Questions

1. What is required in order for QuickBooks to calculate payroll in a real company file?

2. Which two accounts are typically linked to payroll items?

a.

b.

3. Which of the following are QuickBooks payroll item types?
a. Wage
b. Addition
c. Deduction
d. All of the above

4. What report would you run to determine how much you owe in payroll taxes?

5. What QuickBooks feature would you use to make setting up payroll easier when a number of
employees have the same hourly wage, pay period and base deductions?

a. Taxtables
b. Employee defaults
c. Payroll items
d. Assisted payroll
6. True or false: Payroll schedules are required to run payroll in QuickBooks.
a. True

b. False
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7. Payroll schedules help you do which of the following?

a. Group employees with the same pay frequency

b. Write bonus checks

c. Prepare termination checks

d. Pay payroll tax liabilities
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Review Activities

1. Add a salaried employee to the Employee Center. Enter the employee’s personal information,
federal and state tax information, and at least one additional paycheck deduction. Assign the
employee to the monthly payroll schedule.

2. Run the monthly payroll schedule and process a paycheck for the new employee. View the check
in QuickBooks. Open at least one payroll liability account register to see how the paycheck
changes the account’s balance.

3. Select one of the payroll expense accounts from the Chart of Accounts. Create a QuickReport for
that expense account.
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Answers to Review Questions

1. What is required in order for QuickBooks to calculate payroll in a real company file?
A subscription to a QuickBooks payroll service
2. Which two accounts are typically linked to payroll items?
a. Payroll Liabilities
b. Payroll Expenses
3. Which of the following are QuickBooks payroll item types?
a. Wage
b. Addition
c. Deduction
d. v All of the above

4. What report would you run to determine how much you owe in payroll taxes?
Payroll Liabilities Balances

5. What QuickBooks feature would you use to make setting up payroll easier when a number of
employees have the same hourly wage, pay period and base deductions?

a. Taxtables
b. v Employee defaults
c. Payroll items
d. Assisted payroll
6. True or false: Payroll schedules are required to run payroll in QuickBooks.
a. True

b. ¥ False. You do not need payroll schedules to run payroll. You can run payroll without them
by running Unscheduled Payroll or paying an employee a termination check.
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7. Payroll schedules help you do which of the following?

a. v Group employees with the same pay frequency

b. Write bonus checks

c. Prepare termination checks

d. Pay payroll tax liabilities
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